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1 System 

1.1 Single Sign-On Gateway 

The single-sign-on Gateway is now delivered with its own installer. An installation wizard is included. 

Administering and Integrating PerfectForms™ > Administering Connections and Integration > Using Single Sign On > Installing the SSO 

Gateway 

http://www.perfectforms.com/Documentation/manual/html/admin_installing_the_sso_gateway.htm
http://www.perfectforms.com/Documentation/manual/html/admin_installing_the_sso_gateway.htm
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1.2 Audit Logs (On-Premise Versions Only) 

From the Admin console it is now possible to enable audit logs to track system-wide user log-in activity. Audit logs for 

individual users’ log-in activities are automatically available as of version 1.14.  

In the Accounts screen, select the Audit drop-down and click Enable to start the log. The Audit log data will only be 

available if the feature has been enabled. 

The log files may be exported to CSV from here and include Full and Login Actions audit reports.  

In the Accounts screen, select Users. The log files exportable from here include Full and Last Login user reports. The 

User log data does not need to be enabled as these logs are created automatically. 

Administering PerfectForms™ On Premise > Administration Console Home > Accounts > Viewing and Setting Up Account Logs 

1.3 Custom ID Field Added to Public User Signup 

A new field Custom ID is added to the sign-up options. This option is only available (and is mandatory) if the Custom ID 

option is checked on the Account Settings page. 

 

Administering and Integrating PerfectForms™ > Administering Account Settings > Public User Signup in Player 

Instructions for front-end users encountering public sign-up options are included here:  Navigating PerfectForms™ > Logging In 

 

2 Dashboard 

2.1 Moving Forms into Folders 

In the Edit Forms tree, to move a form into a folder when it is not possible to drag it, select the form and right-click and 

select Move. Then put the mouse cursor over the target folder, right-click and select Move To. 

Navigating PerfectForms™ > Edit Forms Tree View > Moving Forms Between Folders in the Tree 

http://www.perfectforms.com/Documentation/manual/html/?inst_viewing_and_setting_up_account.htm
http://www.perfectforms.com/Documentation/manual/html/d_publicusersignup.htm
http://www.perfectforms.com/Documentation/manual/html/nav_logging_in.htm
http://www.perfectforms.com/Documentation/manual/html/nav_moving_forms_between_folders_i.htm
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2.2 Password Change is Forced After Password Reset 

If a user’s password has been reset by an administrator, when the user re-enters the system using the new random 

password they will be forced to set a new password. 

Administering and Integrating PerfectForms™ > Administering Users, Groups and Positions >  Resetting a Password 

2.3 User Blocked After X Failed Log-ins 

In the Account Settings screen it is possible to select the option to block a user after a set number of unsuccessful log-in 

attempts.   If a user is blocked, an admin user must unblock them from the User screen. 

Administering and Integrating PerfectForms™ > Administering Account Settings  

 

3 Form Builder 

3.1 Make Same Width/Height 

To resize multiple objects to the same width and height with one click, select the objects. Then right-click and choose 

Make Same Width or choose Make Same Height. Selected objects will be resized to the biggest selected object. 

Building a Form > Laying Out a Form > Aligning, Spacing and Layering Objects  

3.2 Mandatory Checking of Individual Columns in a Table Object 

It is possible to make a mandatory check of individual columns in a table by using the mandatory check option in 

Column Properties bar or by using the Mandatory Check behavior. 

Building a Form > Laying Out a Form > Working with Tables > Working with Columns 

3.3 Direct Entry of Dates into Date Input Field 

It is possible to enter a date manually into a date input field as well as the option to select from the calendar. Note that 

the date must be entered according to the format set in the Date Input Properties bar. 

Examples:  

If the format is set to DD/MM/YYYY:  Entering 10/03/2009 will set the date as 10th March 2009  

If the format is set to MM/DD/YYYY:  Entering 10/03/2009 will set the date as 3rd October 2009. 

Building a Form > Laying Out a Form > Form Objects Reference Table > Date Input Object  

3.4 Radio Button in a Table Object 

A Radio Button option is available in a table object. This feature allows a user to select and visually indicate a single row 

within the table. 

http://www.perfectforms.com/Documentation/manual/html/admin_resending_a_password.htm
http://www.perfectforms.com/Documentation/manual/html/d_accountsettings11.htm
http://www.perfectforms.com/Documentation/manual/html/align_objects.htm
http://www.perfectforms.com/Documentation/manual/html/fl_adding_new_columns.htm
http://www.perfectforms.com/Documentation/manual/html/fl_object_reference_table.htm#text_inputs_date_time
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Building a Form > Laying Out a Form > Working with Tables > Adding a Table 

Building a Form > Laying Out a Form > Working with Tables > Working with Columns 

Building a Form > Laying Out a Form > Form Objects Reference Table > Radio Button  

 

4 Reporting 

4.1 Color Schemes for Report Objects 

You can specify up to eight colors for pie charts. If there are more than eight slices of the pie chart then the colors will 

be repeated. 

 

You may specify bar and axis colors in bar and line charts. 

 

http://www.perfectforms.com/Documentation/manual/html/fl_adding_a_table2.htm
http://www.perfectforms.com/Documentation/manual/html/fl_adding_new_columns.htm
http://www.perfectforms.com/Documentation/manual/html/fl_object_reference_table.htm#radio_button
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You may specify needle and background colors in a gauge chart. 

 

Building a Report > Adding Objects to Your Report > Adding a Pie, Bar or Line Chart 

Building a Report > Reporting Object Reference > Pie Chart 

Building a Report > Reporting Object Reference > Gauge 

Building a Report > Reporting Object Reference > Bar Chart 

Building a Report > Reporting Object Reference > Line Chart 

5 Integration 

5.1 Migrating Connections 

Connections and their actions can be migrated from one system to another. Use the Migrate button on the Connection 

details in the Perfectforms™ dashboard to export the connection. Use the Import a Connection button to import. 

If you want to migrate a connection and any forms or reports using that connection, follow the recommended 

migration sequence shown below.   

1. Migrate the connection.  

2. Migrate the form.  

3. Migrate the report. 

Administering and Integrating PerfectForms™ > Administering Connections and Integration > Creating PerfectForms™ Connections > 

Migrating and Importing a Connection 

http://www.perfectforms.com/Documentation/tutorials/building%20a%20report/html/adding_a_pie_chart.htm
http://www.perfectforms.com/Documentation/manual/html/r_reporting_reference.htm#piechart
http://www.perfectforms.com/Documentation/manual/html/r_reporting_reference.htm#gauge
http://www.perfectforms.com/Documentation/manual/html/r_reporting_reference.htm#barchart
http://www.perfectforms.com/Documentation/manual/html/r_reporting_reference.htm#linechart
http://www.perfectforms.com/Documentation/manual/html/admin_migrating_a_connection.htm
http://www.perfectforms.com/Documentation/manual/html/admin_migrating_a_connection.htm
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5.2 Connection Agent to Support HTTPS 

Agent Connections (Database and Directory Services) have a new property Use Proxy (for SSL). 

Administering and Integrating PerfectForms™ > Administering Connections and Integration > Creating PerfectForms™ Connections > 

Database Connections 

Administering and Integrating PerfectForms™ > Administering Connections and Integration > Creating PerfectForms™ Connections > 

Directory Services (LDAP) Connections 

5.3 Connection Agent Editor 

A new tool is available which can be used to edit the Connection Agent config.xml file. The tool also includes the option 

to encrypt usernames and passwords. Once encrypted, the file will remain encrypted and can only be modified using 

the tool.  

Important!  Taking a back-up copy prior to encryption is recommended.  Encrypted files can only be read by version 

1.14 of the Connection Agent and higher. 

In the General tab, specify log-ins and IP Address rules. 

 

In the Datasource tab, specify datasource specifications. 

 

Connection Agent Configuration > Installing the Connection Agent Editor 

http://www.perfectforms.com/Documentation/manual/html/d_databaseconnections.htm
http://www.perfectforms.com/Documentation/manual/html/d_databaseconnections.htm
http://www.perfectforms.com/Documentation/manual/html/directory_services_ldap.htm
http://www.perfectforms.com/Documentation/manual/html/directory_services_ldap.htm
http://www.perfectforms.com/Documentation/manual/html/admin_installing_the_connection_agen.htm
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Connection Agent Configuration > Using the Connection Agent Editor 

 

6 List of Defects Resolved 

The following reported bugs were resolved in PerfectForms™ version 1.14. 

 After you go to My Details, you can’t directly select the Settings node in the dashboard tree. 

 Table/Time input column: You can’t gain focus on hours/minutes/seconds using tab, Flash player error 

appears. 

 Error occurs in Reporting when using a file attachment column. 

 Focus on a table with scroll bar is not working when current row is populated from the lookup. 

 Filter Input with Time option is not working on a Time Input Column in a table. 

 When using a Date Input Column (with Now/Specific options) in reporting, next to date, time appears also. 

 The selection of the date calendar object is black (used to be green) and you cannot clearly see the selected 

date. 

 Table/Multiline column: Extra rows are inserted between lines ( after submitting). 

 Pixel distances seem to be different than settings. 

 Modify initial progress indicator (removed PF logo from blue progress box). 

 Player: When user tries to sign up a user with an email that’s already used, the warning message is displayed 

behind text inputs. 

 Player login page: Add warning. 

 Account/License: When Upgrade the Account button is clicked, user is logged out from the application. 

 Incorrect behavior when inputting data into a Table Object. 

 Data in table objects lost when mapped to later version. 

 Warning 1 can be set to Warning 2 in admin console. 

 Unexpected value in new table row - value of previous rows is filled. 

 Connections Help icon is shown twice on the Connections Overview screen. 

 System crashes when a behavior condition verifies if a checkbox column, on a row previously deleted, is 

checked. 

 Table maximum row property is ignored when it is populated from a connection. 

http://www.perfectforms.com/Documentation/manual/html/admin_using_the_connection_agent_edi.htm
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 Home page: Import option from top right edit menu is disable for reports 

 Account/Settings: User must choose own password on log-in label is not completely visible. 

 Reports Printing: Ordering is not respected when printing a datalist. 

 Player displays form details in Web title bar for the embedded forms. 

 Count function for checkbox does not function properly after submit and reopen 

 12 hour clock PM settings are not recognized by behaviors. 

 Object Properties/Overview panel: OK button is not working (only in a specific scenario) 

 Table: Remove one column when other column is hidden generates crash 

 Notification/Time: When Date Taken from a Field has an invalid date format, you can’t submit and a Flash 

player error is shown. 

 Progress bar with 100% will cause printing to fail 

 Printing doesn’t work on attached form because of table border. 

 When Mandatory Answer overview is opened, Mandatory answer tickbox becomes unchecked (only when 

you don’t have stages). 

 Negative numbers are not appearing in printing (numeric input). 

 Printing: User is logged out when he  tries to print a form with a hidden slider (where min value is greater 

than default) 

 Dragging a sound asset on a report - causes flash player error in preview and prevents the report from 

loading 

 Gauge background not appears in printing (only if you create a data list/grid before) 

 Pie Chart with a multiline field is not correctly displayed in printing 

 Bar/Line Chart axes are not correctly reflected in printing 

 Bar/Line Chart: Decimals from vertical axis are not appearing in printing 

 Bar/Line chart: When using a Value(sum - numeric), vertical axis numbers are not visible in printing 

 Report Printing: Data list/grid with a multiline field:  enter key is not correctly interpreted. 

 Numeric values are not correctly reflected in report printing 

 Report Printing: Bar/Line chart: Numbers from vertical axis are not reflected correctly in printing(in some 

case) 
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 Reporting/Data Grid: No data appears if a column is hidden 

 Show report/form changes field data doesn&#39;t make sense as it will never change its data in play mode 

 All columns of a table appear as hidden in printing if the first column is set as hidden and the others as 

default 

 Report printing, Printing crosstab: if one of the grouping fields contains empty data, the corresponding 

column (row) is interpolated with the header column (row) 

 Bar chart Axes: When using Category/Linear nothing is displayed in preview 

 Design mode remains stuck after switching between Edit Forms/Reports/Forms and opening a 

Form/Report/Form again 

 Sliders should allow negative numbers 

 While the audit is enabled the user cannot logout of the application 

 After export, then import a connection on another account, Update action it&#39;s not working anymore 

 Set State command is not respected when the form version is changed. 

 Gauge: Default max limit is empty, it used to be 100. 

 Form Connection actions are not working 

 Login: Forgot password not working; an error is generated and the password is not sent. The user can no 

longer login afterwards. 

 View button for Draft Reports is not disabled anymore. 

 Line Chart: Can’t change the axes type(Segment, Curve, etc). 

 Require login from notification email link option doesn’t work. 

 Signup from player does not work. 

 Migrate Connections: Deleted actions are available after import. 

 Date input format doesn’t work at all. 

 Date input object can be typed in as if it were a text input object. 

 Table data shows in printing after switching from hidden state to default. 

 Mandatory answer for table columns is not working correctly for drop-down and checkbox columns. 

 Reports Printing: Bar/Line chart: Graphic values are not correctly calculated when using Linear/Category 

axes. 
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 Form dependencies appear with $$$; at the beginning in the Import pop-up. 

 Connect Commands Backwards compatibility: If the commands were not saved or created in 1.13 then in 

1.14 the connection and action dd will be empty. 

 Data List/Grid: No data appears if the object has more then 42 columns(system error in debug) 

 Missing Connection/Action when a form that uses it is imported. 

 Backwards: Deleted actions are appearing after import (for old connections). 

 Migrate: When you import a Form connection (after the form) dependencies are missing. 

 Migrate Form connections: If you import the connection and then the form send/return fields are empty. 

Form needs to be reselected. 

 Cannot delete a form instance. System error received. 

 Admin console: Audit trails: Signing up from player will show an error message, only when audit is enabled. 

 System error when trying to view a child instance created with Submit as child even if parent is not 

submitted option. 

 Cannot export reports. 

 Older connect commands (created in 1.13 or prior) based on Form connections no longer working in 1.14 

until they are opened and the form is saved. 

 

 


